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Introduction to RightFax

Objectives

The RightFax system is a network solution for creating, sending, receiving, and 
managing faxes from  your desktop computer. Users can retrieve incoming faxes 
directly from the RightFax system.

This manual covers information about RightFax within Outlook and RightFax  
Connect Utility.

By the end of this manual the user will be able to:

1.	 Access Rightfax
2.	 Receive a fax from Email
3.	 Access RightFax Connect Utility
4.	 Receive a fax from RightFax Connect Utility
5.	 Search for a fax in RightFax Connect Utility
6.	 Send out a fax in RightFax Connect Utility
7.	 Send out a fax through Outlook
8.	 Fax from a Microsoft Office Menu
9.	 Fax from the Task Bar Tray
10.	Use Help Options
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A C C E S S I N G  R I G H T F A X
There are multiple ways to access the RightFax software.  Incoming and outgoing faxes can be 
accessed by email and through the RightFax Connect Utility application.  There is a link to RightFax 
in your system tray area in your task bar.  Outgoing faxes can be sent using the print menu in your 
existing office program.  
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I N C O M I N G  F A X E S  V I A  E M A I L

1.	 Select the inbox or folder that has been established for RightFax incoming faxes. 
2.	 Select the email notification to see fax details. 
3.	 If the fax is able to be retrieved from the email notification, or as an attachment, open the 

fax from the email.  For the example above, the fax has been sent in PDF format and can be 
opened the same way a standard email with a PDF attached can.  

4.	 If you cannot access the fax directly from the email notification, open the RightFax Connect 
Utility to access your fax. 

 INBOUND FAX VIA EMAIL

When a fax has been received by RightFax, a notification should appear in the designated email 
inbox.   

Incoming faxes can be found in your inbox by selecting the designated email inbox for RightFax 
in Outlook.  Follow these steps to view inbound faxes in Outlook: 

If you need to have an inbox created for this step, or have a fax line converted to RightFax, please 
contact Rowan Support at support.rowan.edu or 856-256-4400. 
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R I G H T F A X  C O N N E C T  U T I L I T Y

RIGHTFAX CONNECT UTILITY HOME SCREEN

In the RightFax Connect Utility application, incoming faxes can be accessed and viewed.  If a fax 
has been received via email but the email was deleted, the fax can still be accessed via the RightFax 
Connect Utility application.  In addition, faxes can be sent through the  RightFax Connect Utility.  

Open RightFax Connect Utility on your computer through either the start menu, desktop shortcut, 
the task bar, or applications folder. 
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I N B O U N D  F A X E S  I N  R F C  U T I L I T Y

INBOUND FAXES VIA RIGHTFAX UTILITY

1.	 Select  the All folder to see the current faxes.
2.	 If the All folder is not visible, select the + sign next to the user folder.  The All folder 

should now be visible.
3.	 To open the fax, double-click on the fax title.
4.	 To make the fax appear darker, select the Tools menu, select Gray Scale, then select 16 

Shades.
5.	 You can now Print, Email, or Save the fax.  These options are found in the File menu.

Inbound faxes can be accessed in the utility program by selecting the designated location within 
the application.  Follow these steps to view inbound faxes in RightFax Connect Utility: 
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R F C  U T I L I T Y
In the RightFax Connect Utility application faxes can be sorted, viewed, and searched. 

1 2 3 4 5 6

1.	 Indicates if the document was sent or received.  Inbound 
faxes are shown with a yellow down arrow and outbound 
faxes are shown with a green up arrow.  

2.	 Indicates if the document was viewed.
3.	 Indicates if the document was printed.
4.	 Indicates if the document was OCRed.
5.	 Indicates if the document has a PDF attached.
6.	 Indicates if the document is Certified, Secure, or Email.
7.	 The categories listed below can be used to sort faxes 

using specific criteria.  To change the criteria, right click 
on the category and select a different option listed.  To 
see more options, select the triangle at the end of the list. 

7 7 7 7 7

7
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R F C  U T I L I T Y  S E A R C H

UTILITY SEARCH OPTIONS

1.	 In RightFax Connect Utility select the Tools menu, then the Search option.
2.	 Or you can hold down the control key on the keyboard (command key for a mac), and 

tap the F key.  This will bring up the same search bar in the RightFax Connect Utility. 
3.	 A search box will appear and you can type in anything that might help locate the 

fax.  This includes the sender name, office name, title of the fax, or other identifying 
information.  Any faxes that meet the search criteria will appear. 

4.	 There is also an Advanced Search option on the home screen.  This is another way to 
do an extensive search using a combination of criteria you set.  

If you have trouble locating a fax, you can search for the fax in the RightFax Connect Utility.
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O U T G O I N G  F A X E S  I N  R F C  U T I L I T Y

FAX A DOCUMENT FROM RIGHTFAX CONNECT UTILITY

1.	 In RightFax Connect Utility select the New Fax button or under the File menu on the left corner 
of the window, select the New Fax option.

2.	 Enter the outgoing fax number into the prompt and any important information in the 
corresponding fields.

3.	 If you are using a cover sheet, make sure the Use Cover Sheet box is checked.
4.	 If you would like the fax held for preview before it is sent, check the box Hold for preview.  If the 

fax is held, you will need to right-click on the fax and select Status and then Release to send the 
fax when you are ready. 

You can fax a document from RightFax Connect Utility, and include a cover sheet.  
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O U T G O I N G  F A X E S  I N  R F C  U T I L I T Y

COVER SHEET AND ATTACHMENTS

1.	 Add information in the Cover Sheet Notes tab that  you wish to appear on the cover sheet. 
2.	 Find the document on your computer you would like to fax using the paperclip icon in the 

Attachments tab.
3.	 Select Send. 

You can add information to the cover sheet and add attachments.  
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F O R W A R D  F A X E S  A N D  R O U T E  T O  U S E R

FORWARD OR ROUTE A FAX

1.	 In the toolbar select the Forward to User or Route to User button to send a fax to another 
user.

2.	 Enter the outgoing fax number into the prompt and any important information in the 
corresponding fields. 

3.	 If you are using a cover sheet, make sure the Use Cover Sheet box is checked.
4.	 Add information in the Cover Sheet Notes tab that  you wish to appear on the cover sheet.
5.	 Select Send. 
6.	 If you are routing to another RightFax user in your network, a box will appear listing users.  Find 

the user you would like to route the fax to, and double click on their name to select that user.  
If routing the fax to more than one user, keep double clicking on users until they are all added.  
Select OK to send. 

You can forward and reroute a fax document from RightFax Connect Utility.  Forward sends the fax 
to the user and keeps a copy.  Route sends a copy and deletes your copy when complete.  

Fax List Tools Help 
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O U T B O U N D  F A X E S  I N  O U T L O O K 

1.	 If your document needs to be scanned prior to sending, open up your scanning program and 
scan your document.  Save the scanned document to your computer. 

2.	 Select Send a Fax from the toolbar in Outlook.
3.	 Enter the receiver’s name and company and select the To button to enter the recipient in the fax 

addressing section of the email at the bottom.
4.	 Fill out the subject in the email subject field and add any attachments you would like to fax. 
5.	 If you need a cover sheet included make sure you check the  Use Cover Sheet box and include 

the information you need in the cover sheet tab. 
6.	 Choose your sending options.  Hold for preview will preview the message before sending.  

Smart Resume will pick up where the message left off if sending gets interrupted by network 
connection issues. 

7.	 Select the Send button, as you would normally send an email. 

SEND A FAX FROM OUTLOOK

If you have the option installed, you can send outgoing faxes from Outlook.    
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O U T B O U N D  F A X E S  I N  O F F I C E

FAX USING PRINT 

1.	 After completing your document select Print. 
2.	 In the Print menu choose RightFax Fax Printer.
3.	 Select Print. 
4.	 Enter the outgoing fax number, name, and any important information in the corresponding 

fields.
5.	 If you are using a cover sheet, make sure the Use Cover Sheet box is checked.
6.	 Add information in the Cover Sheet Notes tab that  you wish to appear on the cover sheet. 
7.	 Select Send. 

You can fax a Microsoft Office Document right from the document using the Print function. 
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O U T B O U N D  F A X E S  U S I N G  T A S K  B A R  I C O N

TASK BAR ICON

1.	 In the task bar select the RightFax icon button. 
2.	 Enter the outgoing fax number into the prompt and any important information in the 

corresponding fields. 
3.	 If you are using a cover sheet, make sure the Use Cover Sheet box is checked.
4.	 Add information in the Cover Sheet Notes tab that  you wish to appear on the cover sheet. 
5.	 Find the document on your computer in the  Attachments tab.
6.	 Select Send. 

If your system is configured accordingly, outgoing faxes can be sent by using the RightFax icon in 
your system tray area in your task bar.  
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R I G H T F A X  H E L P  O P T I O N S

RIGHTFAX CONNECT UTILITY HELP MENU

1.	 Go to your computer’s modern internet browser.
2.	 Enter https://thefaxguys.com in the browser address bar.
3.	 On the website menu bar select RightFax University. 
4.	 At the top of the website place your cursor over Videos and select a video on the topic you are 

looking for, or use the search box provided to you.
5.	 Any videos on the topic will load in a list and you can watch the video free of charge.

If you have trouble using Rightfax, the RightFax Connect Utility has a very useful help menu. 

To get to the RightFax Connect Utility help menu, select Help, then Contents.  The topics offered 
are listed on the left side menu.  There are articles on common topics.  Once you select a topic, 
the article appears with articles on related topics listed underneath.  In addition to the help menu, 
OpenText, the developer of RightFax, owns The Fax Guys, an organization offering tutorial videos for 
the RightFax system.  To get to The Fax Guys tutorials, follow these steps:

Support options for RightFax:  If you are unable to get notifications, retrieve or send your fax from 
either email or the RightFax Utility application, or have any issues while accessing RightFax or the 
Utility Application, Contact RightFax support at 1-800-540-7292.  If you are having difficulty with 
document management, please contact Rowan Support at support.rowan.edu or 856-256-4400.   
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Getting started 

RightFax FaxUtil is the central Windows-based mailbox from where you manage your faxes and those for whom you act as a delegate. The left pane shows the 
available folders, the right pane the faxes within the selected folder, with flags showing the action taken on the fax, and the status indicators showing the current 
status of the fax. 

] Fax flags: il = sent ii = received, = printed, !:lil = converted to text (OCR), '!:I = converted to PDF, ~ or lit sent or received fax forwarded to another 

J RightFax user. In addition, flags can indicate the document type: I = certified delivery message, = SMS message, 0 =Emailed, □ = Fax routed to email. 

Status indicators: 0 = being processed for transmission, • = transmitted, <D= not transmitted due to error; will be retried, 0 = not transmitted due to error; 
will not be retried. You can force the server to retry sending faxes with a yellow or red status. See Sending faxes. For detailed information about status 
messages, see Fax status and error messages 

I Note If you forget your RightFax password, contact your fax administrator to assign a new one. To change your password, see Changing your password and 
default user information. 

0 Showing the most current list of faxes 

Sending faxes 

Viewing the fax list 
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